What’s new in Spotfire® 6
## Contents

Introduction ............................................................................................................. 4

- New Location Analytics capabilities ................................................................. 4
- New Mobile capabilities ..................................................................................... 4
- New Event-Driven Analytics capabilities ......................................................... 4
- New Web-based Data discovery capabilities ................................................... 4
- New cloud deployment capabilities ................................................................. 4

Updated product names and packaging .............................................................. 5

- TIBCO Spotfire® Analyst 6.0 (new) ................................................................. 6
  - Mapping ........................................................................................................ 6
  - Authoring of Mobile Metrics ...................................................................... 8
  - Forecasting ................................................................................................. 8
  - R Language Scripting with TERR ............................................................... 9
  - Application building ................................................................................. 10
  - Images on axis ......................................................................................... 13
  - Upload and store data to the library ......................................................... 14
  - Data Access ............................................................................................... 14

- TIBCO Spotfire® Business Author 6.0 (new) .................................................. 17
  - Creating new analyses or opening local analyses with the Library Browser .. 17
  - Add or replace data ................................................................................... 18
  - Create new visualizations ......................................................................... 18
  - Drill down - create details visualizations .................................................. 19
  - Interaction with visualizations through the column selector ................. 20
  - Visualizing data using trellis (small multiples) ....................................... 21
  - Comparing Subsets .................................................................................. 21
  - Other general functionality ..................................................................... 22
  - Configuring additional visualizations properties .................................... 23

- TIBCO Spotfire® Consumer 6.0 (new) .......................................................... 24
  - Mobile Metrics ........................................................................................... 24
  - Mobile Analytics ....................................................................................... 25
  - Improved Library Browser ....................................................................... 25
  - Other Improvements ................................................................................ 26
TIBCO Spotfire® Cloud Personal ................................................................. 26
TIBCO Spotfire® Cloud Work Group.......................................................... 26
TIBCO Spotfire® Cloud Enterprise............................................................. 27
TIBCO Spotfire® Server 6.0.................................................................. 29
TIBCO® Enterprise Runtime for R (TERR) 2.0........................................... 30
  Explicit parallelization ........................................................................ 30
  Compatibility with RStudio™ .............................................................. 30
  RinR package ..................................................................................... 31
  Expanded core R coverage and CRAN package support ...................... 32
  TIBCO StreamBase® Integration ......................................................... 33
  Compatibility with ESS (Emacs Speaks Statistics) ......................... 34
TIBCO Spotfire® Statistics Services ......................................................... 34
  TERR 2.0 engine .............................................................................. 34
  Support for open source R versions 3.0.x .................................. 34
TIBCO Spotfire® Event Analytics .............................................................. 34
TIBCO Spotfire® 6.0 System Requirements ........................................... 35
Introduction
A major milestone in data visualization, Spotfire® 6 provides a new series of innovative capabilities that dramatically extend the impact analytics can have on an enterprise of any size. Spotfire® 6 helps you extend the use of analytics to all corners of your business with new cloud options, and more powerful location capabilities, as well as unmatched event processing, additional data access options, and far better mobility. With the introduction of web based authoring your Business consumers are easily transformed into Business authors.

New Location Analytics capabilities
Spotfire® 6 allows for unprecedented speed and ease-of-use in visualizing, exploring, and analyzing data in the context of geographic information. For example, users are able to expand situational understanding through the use of multi-layered maps, automatic geo-coding, and data overlay. This results in new, easily understood analytic applications, promoting self-service discovery and visibility into the unknown.

New Mobile capabilities
With the consumerization of IT and increasingly mobile workforces, employees expect immediate access to accurate and relevant operational information wherever they are. They need the right information at the right time, on the right device, in a form that user understands. Spotfire® 6 delivers on this need through TIBCO Spotfire® Metrics, which presents up-to-date key performance indicators on a comprehensive range of mobile devices, supporting capabilities such as offline KPI monitoring, contextual drill down, and social collaboration.

New Event-Driven Analytics capabilities
TIBCO Spotfire® Event Analytics is a new add-on to the Spotfire® platform that enables Spotfire® users to analyze and optimize real-time processes, in turn providing access to a new universe of real-time data sources. Event Analytics alerts users to events such as impending business opportunities; users can analyze these events in context, mashing up data at rest with data in motion, and immediately take action. The results help drive revenue and reduce costs.

New Web-based Data discovery capabilities
Bridging the gap between simple dashboards and advanced analytics applications, Spotfire® 6 has created TIBCO Spotfire® Business Author, a new client tailored to meet the needs of the everyday business user. With this new web application, manipulating pivot tables and charts to address data discovery needs is simpler, making it easier to explore and interact with data, whether in a simple spreadsheet, a dashboard, a database, or a predefined analytic application.

New cloud deployment capabilities
TIBCO Spotfire® Cloud is a set of three new cloud services for enterprises, work groups, and personal use. TIBCO Spotfire® Cloud Enterprise provides a secure full-featured version of Spotfire. TIBCO Spotfire® Cloud Work Group provides a wealth of application-building tools for distributed teams. And, for individuals looking for single-step actionable insight, TIBCO Spotfire® Personal is a cost-effective web-based client for quick data discovery needs.
Updated product names and packaging

TIBCO Spotfire® 6 adds a range of new and updated products to the offering. To accommodate these updates and prepare for the future while keeping the packaging clean and easily understandable a new product packaging has been introduced. Product capabilities have been regrouped and new product names have been introduced. The table below lists new products and capabilities mapped to previous products and capabilities.

<table>
<thead>
<tr>
<th>New On-Premise Product in TIBCO Spotfire® 6</th>
<th>Components included</th>
<th>Notes</th>
</tr>
</thead>
</table>
| TIBCO Spotfire® Analyst                   | TIBCO Spotfire® Professional 6.0  
TIBCO Spotfire® Metrics Modeler 6.0      | TIBCO Spotfire® Analyst allows analysts and application developers to perform advanced analytics, create analytic applications and dashboards and define mobile KPIs.  
With an active maintenance agreement for TIBCO Spotfire® Professional an update to TIBCO Spotfire® Analyst is available. |
| TIBCO Spotfire® Business Author            | No installation but requires the component TIBCO Spotfire® Web Player 6.0 to be deployed | TIBCO Spotfire® Business Author gives business users the power of visual data discovery and the ability to create and share business visualizations.  
TIBCO Spotfire® Business Author is a new product introduced with TIBCO Spotfire® 6 with its own new license. |
| TIBCO Spotfire® Consumer                   | A new product with its own new license. Includes the component TIBCO Spotfire® Web Player 6.0 | TIBCO Spotfire® Consumer gives business users and executives the ability to view and interact with analytic applications, dashboards and mobile KPIs.  
With an active maintenance agreement for TIBCO Spotfire® Web Player an update to TIBCO Spotfire® Consumer is available. |
| TIBCO Spotfire® Metrics Author             | A new product with its own new license. Contains the components TIBCO Spotfire® Metrics Modeler 6.0 and | TIBCO Spotfire® Metrics Author gives analysts the ability to define mobile KPIs.  
TIBCO Spotfire® Metrics Author is a new |


TIBCO Spotfire® Analyst 6.0 (new)
TIBCO Spotfire® Analyst is the new name for TIBCO Spotfire® Professional. Version 6.0 has a number of major improvements:

- Mapping - a new multi-layered map chart with access to TIBCOs online maps, including the ability to geocode data worldwide.
- Authoring of Mobile Metrics - a new modelling client for creating and deploying personalized business metrics to mobile devices.
- Forecasting - an integrated forecasting tool that enables users to plot a predicted line, as well as confidence intervals for predictions.
- Application Building - Improvements include the ability to control layout of the Text Area in HTML, adding background color or image to the text area, and creating more responsive applications using Iron Python scripts. User can also create applications using Java Scripts.

The following chapters provide more details on these new capabilities.

**Mapping**
TIBCO Spotfire® Analyst 6.0 provides the ability to analyze business data in the context of geography. This new context helps users drill down into their data to discover new information, trends and correlations in an interactive way.

**Create MapChart easily**

Spotfire® Analyst 6.0 release introduces built-in geocoding tables and associated shape files for automatic mapping visualizations of data at five levels: Country, Admin 1, Admin 2, Zip Code, and City. When users create a new Map Chart visualization, Spotfire® automatically detects geographic
Spotfire® 6.0 provides geocoding for the following geographic areas:

1. World hierarchy
   a. World Countries (level 0)
   b. World Countries and Regions (level 1)
2. Countries hierarchy: Australia, Canada, France, Germany, Japan, Mexico, New Zealand, Sweden, UK and USA
   a. Country Regions (level 1)
   b. Country, Regions and Counties (level 2)
   c. Country, Regions, Counties and Cities (level 3)
   d. Country, Regions, Counties, Cities and Zip codes (level 4)

Spotfire® Analyst 6.0 gives users the ability to visualize business data in the context of a high-precision base map background layer. Multiple base map styles are offered by default in Spotfire. This feature requires an Internet connection.

Visualize multiple layers of data

Spotfire® 6.0 enables users to visualize, explore and analyze multiple layers of data from multiple datasets on the same Map Chart, as well as mixing thematic map layers and marker layers to better understand relations and trends between their own business data or contextual data.
Geographically drill down into the data

With Spotfire® 6.0, you can zoom and pan maps more dynamically for better data exploration. Users have complete flexibility to create geographic drill downs, in order to choose specific zoom levels from global, high-level summaries to detailed, granular information. Paired with intuitive map navigation, decision-makers can see both the big picture and the root causes of relevant business conditions.

Authoring of Mobile Metrics

Spotfire® Analyst 6.0 includes access to the TIBCO Spotfire® Metrics Modeler client, which allows business analysts to define key performance indicators (KPIs) and other business metrics. These metrics can then be easily personalized according to end user roles and permissions, and deployed across the organization to decision makers on their preferred mobile devices.

Defining regional sales KPIs using TIBCO Spotfire® Metrics Modeler client.

Forecasting

Spotfire® Analyst 6.0 provides an integrated forecasting tool that enables users to create a forecast on a time series. A forecast can be created with a simple right-click, as well as more advanced configuration settings, such as whether to include seasonal components and confidence intervals. These settings are available from the “Lines and Curves” section of the properties dialogue.
Forecast in a line chart, including the fitted line (black solid), the forecast (black dots) and 95 % confidence intervals (red dashes)

R Language Scripting with TERR
Spotfire® Analyst provides access to R language scripting capabilities, using the local TIBCO® Enterprise Runtime for R (TERR) engine. TERR is embedded in Spotfire® Analyst, and users can create their scripts using Tools > Register Data Functions, and then use their scripts via Insert > Data Functions. This provides the power of the R language and the statistical capabilities of the R Community to Spotfire® personal users. Furthermore, a suite of Sample Data Functions and analysis files are provided in the Sample Data Functions directory of the Spotfire® library,
Application building
Spotfire® Analyst provides a set of new features that enable authors to create more visually appealing and interactive dashboards.

Buttons to access background color, background image and HTML edit mode in the Text Area

Some of the most useful of these new features include:

Set the background colour or image
Spotfire® Analyst 6.0 enables users to select the background color of the text area, or even define a background image for the text area.

Detailed control over layout
Spotfire® Analyst 6.0 enables editing the text area contents using HTML. This enables more detailed control over layout and enables using HTML tables in the text area.
**Enabling more advanced applications**

Spotfire® Analyst 6.0 enables more responsive applications by triggering a script on a document property change. The user can register a script for a document property and the script will be executed when the document property changes. This can, for example, be used to trigger a script when the user selects a value in a drop down list.

This is a simple application that allows the user to select for which state to show data. Data for the visualization is limited by an expression using the document property set by the drop down list, and the title of the visualization is set to the value of the selection.

In addition, Spotfire® Analyst 6.0 enables inserting Java Scripts in the the Text area. This provides advanced authors a multitude of possibilities, such as using Java Script controls like DatePicker.
Spotfire® Analyst 6.0 also includes a new API to update Data Function Definitions. This enables the creation of more flexible and powerful applications that utilize advanced analytics from TERR or other statistical engines. Using this API, application authors can use Python scripts to programmatically create or modify Data Functions, including extracting, updating, and rerunning statistical language scripts.
This is a simple application that allows the user to load and update Data Functions embedded in a Spotfire® analysis file.

**Images on axis**

In Spotfire® 6.0 users are able to configure Scatterplots, Bar charts, Line charts, Combination charts and Heat maps to show images on the axis of visualizations. This can be used for a variety of purposes, such as showing images of the molecules included in an experiment, or displaying national flags instead of, or in addition to, country names.

![Example of a bar chart with molecule-images on the categorical axis](image)

There are several options for how to access the images that show up on the axis, and these options are similar to the options in earlier versions of Spotfire.
Upload and store data to the library

TIBCO Spotfire® Analyst 6.0 enables the user to upload and store data in the library independently from any analysis. The data can then be accessed and used for the creation of new analyses or used to add a new data table to the open analysis.

Export data to library menu selection

Users select which data table to export and the data will then be stored as a SBDF file (Spotfire® Binary Data File).

Data Access

Spotfire® 6 not only continues to add support for new high value data sources, but also enables new data access scenarios to unlock the combination of the built-in analytic power of Spotfire® with the built-in power of external high value data sources. This means it’s now possible to combine in-database analytics with in-memory analytics using a single data connection. A typical drill down scenario is to explore a petabyte source using an in-database approach, drilling down to a slice of row level data that is brought into Spotfire’s in-memory data engine on-demand. This scenario enables advanced row level analytics, while using a single connection to the source without the need for Information Services or ADS.
Multiple Spotfire® tables per Connector view is now possible

Multiple load methods allows different sources to have different source methods

On-Demand can be defined on a per table basis. It is disabled by default.

The in-database, in-memory, and on-demand connection dialog

Standard On-Demand Settings Dialog with Define Input capability
If checked the table will show up in the table selector. Uncheck for tables that shouldn’t be visible, e.g, Geocoding tables etc.

Cache calculated columns when saving analysis file

Spotfire® 6 adds support for three new database sources. Native support is now available for one of the most popular OLAP cubes on the market today, especially within the financial industry; Oracle Essbase. We are also strengthening our partnership with Teradata by adding support for Teradata Aster. In addition, the powerful hybrid in-memory/on-disk storage solution HP Vertica is now also natively supported by Spotfire. We have also radically strengthened our support for SAP BW by adding support for BEx queries with variables.
We have also improved transformations, which can now be applied independently from the import step (previously they were defined during the import step). They are accessible through the Insert menu -> Transformation, and is applicable to in-memory data.

**TIBCO Spotfire® Business Author 6.0 (new)**

TIBCO Spotfire® Business Author is the new web-based authoring environment in the Spotfire® family. It runs from the same server as the TIBCO Spotfire® Consumer (former Web Player), but access to the authoring functionality is controlled by a specific license that the customer administrator can set for selected groups of users.

Business Author provides an easy to use and easy to deploy authoring environment for business users that enables self-service analytics. Business users may extend existing analyses to answer more questions or create entirely new analyses. In addition, Business Author enables the user to create new visualizations, change what is displayed on the axis of visualizations, and even create their own drill down (details visualizations) with just two clicks of a mouse.

**Creating new analyses or opening local analyses with the Library Browser**

In addition to the general library browser improvements available to all web users, the users of Business Author are also able to create a new analysis from an existing information link in the library, or one based on local data or opening a local .DXP file.

```
Library > amylande

<table>
<thead>
<tr>
<th>Name</th>
<th>Modified</th>
<th>Modified by</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales and Cost</td>
<td>08/21/2013</td>
<td>amylande</td>
</tr>
<tr>
<td>Sales and Cost IL</td>
<td>08/09/2013</td>
<td>amylande</td>
</tr>
<tr>
<td>Sales and Cost IL prompted</td>
<td>09/11/2013</td>
<td>amylande</td>
</tr>
</tbody>
</table>
```

Clicking on an information link in the library creates a new analysis based on the data in the information link.
Create new analysis from a local file or open a locally stored DXP file

Add or replace data
The user is able to add more data to an existing analysis, and to replace an existing data table in an analysis, in order, for example, to visualize the data for the latest quarter.

When adding data to an analysis that already contains data, Business Author will attempt to automatically detect matching columns based on the following criteria: If there are columns with exactly the same name and if the type is exactly the same in the existing and the new data set, a match will be created and it will be possible to visualize data from both tables in the same visualization.

Create new visualizations
Business Author enables the user to create new visualizations of the following types:

- Bar chart
- Line chart
- Scatterplot
- Table
- Cross table
- Pie chart
• Combination chart (Bar and Line)
• Treemap
• Parallel Coordinate Plot

These are the visualization types that can be created in TIBCO Spotfire® Business Author

Drill down - create details visualizations
All visualization types that can be created in Business Author can also be used in order to drill down to more details of the data. Simply right-click while in the visualization from which you want to start the drill down.
Drilling down into the details by creating a details visualization (in this case a table)

Interaction with visualizations through the column selector

The primary way of interacting with visualizations in the TIBCO Spotfire® Business Author is through the column selector. The column selector is used to select what data to show and also what aggregation methods to apply on the axes of visualization.

Column selectors in a bar chart

In addition, by right-clicking on the column selector the user can select to remove all columns currently displayed on an axis, invoke the select columns interface, or enter custom expressions.
The select columns interface is particularly useful when there are many columns to display in visualization; furthermore, custom expressions allow the user to customize what is displayed on the axis of visualization, such as showing the difference between two columns.

**Visualizing data using trellis (small multiples)**

Users can select which criteria to use for Trellis display of visualization in the property pop-over.

**Comparing Subsets**

Business Author enables the user to compare predefined subsets of data, such as all available data vs the data in the current filtering.
Example of showing all data in grey vs data in the current filtering in red

**Other general functionality**
The menu bar in Business Author provides a range of general functionally, which is useful when authoring analyses and analyzing data.

- Save/Save as
- Add or Replace Data (previously described)
- Undo/redo
- Show or hide the Filter Panel
- Show or hide the Details On Demand panel
- Add/edit/apply Bookmarks
- Collaboration – share visualization over Tibbr (this requires that the .DXP has been configured for collaboration)
- Create New page or rename page
- Arrange visualizations (maximize, side-by-side, stacked etc.)
- Reorder pages through drag and drop
Configuring additional visualizations properties

All visualizations support additional configuration from the properties pop-over, which can be accessed from the menu bar or from the visualizations top right corner. From the properties pop-over the visualization can be configured in the following aspects:

- **Title**: the title of the visualization can be configured.
- **Data**: select which data table to base the visualization on (if more than one exists).
- **Axes**: configure what is displayed on the axes of the visualization and select which format to display it in.
- **Shape**: (only available for scatter plot): configure what shape to use for markers.
- **Color**: Configure by which column to use for deciding the color of the markers/bars/lines. This is also possible directly from the legend.
- **Size**: the size of markers (Scatter plot only).
- **Labels**: user can configure how marker labels are displayed, for all, none, or marked data points.
- **Legend**: configure what data to show in the legend.
- **Error Bars**: configure the display of error bars in a barchart, line chart, scatterplot.
- **Compare Subsets**: configure comparison of the subsets “all data,” “current filtering,” and “not in current filtering.”

In addition, some plots support more options, such as the horizontal/vertical orientation of barchart.
**TIBCO Spotfire® Consumer 6.0 (new)**

TIBCO Spotfire® Consumer – formerly known as TIBCO Spotfire® Web Player – puts the power of guided analytic applications and dashboards into the hands of decision makers in any organization.

In version 6.0, a number of major improvements have been made, such as:

- Mobile Metrics – Fingertip access to KPIs and other business metrics on any mobile device, online or offline.
- Improved Library Browser – An improved, more visual library browsing experience.
- Improved Panel Visibility – Analytics consumers now have more control over panel visibility in the web client for analytic applications.

The following chapters provide more details on these capabilities. A few minor enhancements have also been implemented:

- It is now possible to configure the web player client to logout and display the login page when a configurable user-inactivity timeout is triggered.
- It is now possible to configure the web player not to display user IDs in the UI.

**Mobile Metrics**

Spotfire® Consumer allows for easy consumption of up-to-date mobile KPIs and business metrics on any mobile device. Simple, performance-focused views show at a glance how your business is performing against established targets.

With native app support across a variety of mobile platforms and devices, users are free to explore their most important business information using intuitive, touch-based gestures. Additionally, offline support on the tablet apps allows mobile users to take their most important information with them, even when network connections are unreliable.

The TIBCO Spotfire® Metrics family of mobile apps can be downloaded from the following app stores:

- Apple App Store for iOS (iPad and iPhone)
- Google Play for Android (tablet and smartphone)
- Windows (tablet and smartphone).
Sample view of sales metrics in TIBCO Spotfire® Metrics for Apple iPad

NOTE: For authoring of mobile metrics, see related chapter Authoring of Mobile Metrics.

Mobile Analytics
The TIBCO Spotfire® Analytics app for Apple iPad has a beautiful new user interface designed to match Apple iOS 7.

In addition to the new style, the app includes:

- Gallery view – a highly visual, user-curated collection of favorite analytic applications.
- Location awareness – filter or update data views based on a user’s current location.
- Bar code scanning – filter or update data views based on a UPC, QR Code, or other bar code that the user scans.

Improved Library Browser
Spotfire® Consumer has a new library browser, which allows user to navigate the library structure by browsing or searching.
**Other Improvements**

Users can now toggle the visibility of the filter and details when viewing demand windows.

**TIBCO Spotfire® Cloud Personal**

Spotfire® Cloud Personal is a new cloud product offering launching in November for individual business users. Through the new 6.0 TIBCO Spotfire® Business Author capability, Cloud Personal users can upload local files to create new analyses from scratch, and can author, edit and save to a web-based library. Spotfire® Cloud Personal users will not have access to the Analyst thick client. Users of Silver Spotfire® Personal and Silver Spotfire® Personal Plus will be upgraded Spotfire® Cloud Personal on launch day. Spotfire® Cloud Personal can be purchased via credit card through the new Spotfire® Cloud website, where users can manage their account, payment and user profile information, and access their product.

**TIBCO Spotfire® Cloud Work Group**

Spotfire® Cloud Work Group is a new cloud product launching in November. It allows small groups of data analysts, business authors, and data consumers to collaborate and perform business analytics. Cloud Work Group includes one Business Author browser-based seat, one Analyst client seat, and five named Consumer seats. Users of Silver Spotfire® Publisher and Silver Spotfire® Analyst will be upgraded to Spotfire® Cloud Work Group. Spotfire® Cloud Personal can be purchased via credit card through the new Spotfire® Cloud website, where users can manage their account, payment and user profile information, and access their product. Customers can also purchase Spotfire® Cloud Work Group through our sales team via Purchase Order.
It is important to note that while Cloud Work Group users benefit from most of the functionality available in TIBCO Spotfire® Analyst, we have turned off functionality like Information Services, iron python scripting, and other server-side administrative tasks to ensure the highest level security this multi-tenant SaaS environment.

TIBCO Spotfire® Cloud Enterprise
TIBCO Spotfire® Cloud Enterprise is a new cloud product offering in November 2013. It is a cloud-based data discovery platform hosted by Spotfire® Development Operations. We create a private, single-tenant and highly secure environment for each Cloud Enterprise customer and deliver the environment within five business days of a completed order. Enterprise customers customize the number of Analyst, Business Author and Consumer seats they need, and choose from our full suite of products and services, including Automation Services, ADS, and Statistics Services. Beginning in 6.0, Cloud Enterprise Analysts and Consumers will also have access to KPI and dashboarding capabilities.

Each Spotfire® Cloud Enterprise environment is deployed with a Spotfire® Server(s), Web Player Server(s) and Spotfire® Metrics Server and Modeler. The environment is much like a standard on premise deployment, except that our ISS/Development Operations team takes care of all the maintenance, upgrades, backups, monitoring and performance tuning of the systems. The highly available systems are securely deployed in Amazon Web Services and provide customers with the ability to connect back to their corporate data center. Just as with an on premise Spotfire® environment, applications can scale to meet the customer’s needs. The following diagram illustrates the basic deployment.
All Spotfire® related applications are in a private subnet. It is not possible to make inbound/outbound connections to/from these instances directly. All inbound level access is controlled through the load balancer, and outbound connections are controlled by the NAT instance, each found in the public subnet.

The diagram above also shows a Virtual Private Gateway back to the customer’s data center. This is optionally available and has the benefit of allowing the customer to access local systems (e.g. Active Directory, in the event their directory is not exposed externally by some other means). If the customer chooses this option, they will need a supported gateway device. Currently, PSG services are required to enable this option.

The environment comes pre-configured with SSL, and we can also work with customers to configure SSL for a custom domain name that they provide. By default, the customer can review all details related to their environment at https://<customer_name>.spotfire-cloud.com/details.

Here is a sample Cloud Enterprise customer portal:
The Spotfire® server has been enhanced with a number of new capabilities and features listed below:

- The log user actions introduced in Spotfire® 5.5 has been extended, with support for continuous logging of system performance values from the Spotfire® server instances. This will make it easier to draw conclusions on the server load and user actions, as well as data access usage patterns. The default analysis file included in the Library has been updated with new corresponding visualizations.

  Sessions - An overview of the number of sessions over time, along with detailed user activity.
  Users - Shows logged in users, together with detailed user activity drill down.
  Library - Statistics on frequently used library files, file sizes and file growth.
  Information Links - Statistics on frequently used information links, amount of transferred data and retrieval times.
  Local Files - Statistics on local files.
  Data Connectors (1-4) - Statistics on the usage of data connectors.
  TSS/TSWP Monitoring - Tibco Spotfire Server/Web Player monitoring.
  Detailed Logs - All logged items.

- A new command “show-library-permissions” is now available. It will return a table showing who has access to what in the Library. The table is copy/paste compatible for Spotfire® analysis.
- The Server Configuration Tool can now be run from a different machine than the server.
- Install and configure Spotfire® server on Linux without root privileges.
• Enable dumping of threads and memory on the server to file for troubleshooting tasks
• Authentication filters can be used for blocking all requests from a certain IP address or country
• Usernames can now be retrieved from header, cookie, or the Authentication filter.
• All configuration enhancements makes it possible to configure both via command line and Configuration Tool

TIBCO® Enterprise Runtime for R (TERR) 2.0
TERR has been enhanced with a number of new capabilities and features:

Explicit parallelization
TERR now provides greater scalability by enabling users to write parallelized R-language scripts, using syntax similar to the parallel library in Open Source R. Both local (multicore) and remote (multi-machine using Statistics Services) parallelization is supported.

A sample application that uses the new parallelization capabilities in TERR to fit multiple predictive models in parallel, and compare their results.

Compatibility with RStudio™
The TERR engine is now compatible with the RStudio IDE, a popular open-source IDE used extensively by the R Community. RStudio provides features such as:

• Syntax highlighting, code completion, and smart indentation
• Execute R code directly from the source editor
• Easily manage multiple working directories using projects
• Quickly navigate code
TERR is compatible with RStudio versions 0.98.456 or later, and the RStudio IDE can be downloaded from the RStudio site. Configuring RStudio to use TERR is as simple as using RStudio Tools > Global Options to choose your TERR installation as your working engine.

*TERR running inside RStudio. The script window, the console, the environment browser, and the tab for managing Packages are shown.*

**RinR package**

TERR includes a new package called RinR, which allows users to easily call out to Open Source R from TERR to create graphics and access other functionality or packages not yet available in TERR. If installed, the RinR package will automatically detect and use Open Source R.
Example of using TERR inside RStudio to generate a graphic using RinR and Open Source R.

Expanded core R coverage and CRAN package support
Approximately 1500 R packages from the CRAN repository now run successfully in TERR. Full details on expanded R coverage and package compatibility can be found on the TIBCOmunity TERR Community Site.
TERR information and resources on the TERR Community Site

TIBCO StreamBase® Integration
TERR now supports integration with TIBCO StreamBase®, and so can be used to perform analytics and score predictive models for real-time operational decision-making. More information on TIBCO StreamBase can be found at www.streambase.com.
**TERR Adapter is now available on the StreamBase Component Exchange.**

**Compatibility with ESS (Emacs Speaks Statistics)**
Users programming in TERR can now use ESS directly with the TERR engine. ESS is available at the ESS Project site, and instructions on using TERR with ESS can be found on the TERR Community Site.

**TIBCO Spotfire® Statistics Services**

**TERR 2.0 engine**
TIBCO Spotfire® Statistics Services has been updated with the new TERR 2.0 engine, giving users access to all the new functionality in this release of TERR, as highlighted in the section above. This includes the ability to use TSSS to run parallelized jobs from TERR scripts (using TERR’s new parallelization capabilities), as well as the ability to call open source R from a TERR script (using the new RinR package).

**Support for open source R versions 3.0.x**
TSSS has added support for open source R version 3.0.x, to enable TSSS users to get the latest functionality from open source R. See the System Requirements on support.spotfire.com for exact R versions supported.

**TIBCO Spotfire® Event Analytics**
TIBCO Spotfire® Event Analytics is a new add-on for the Spotfire® platform that enables Spotfire® users to analyze and optimize real-time processes, and provides access to a new universe of real-time data sources. Event Analytics can alert users to events representing opportunities and problems, and anticipate these events before they occur using Predictive Analytics.

When important events occur, TIBCO Spotfire® Event Analytics uses Spotfire® Automation Services to alert users, and to prepare and deliver Spotfire® analyses that enables users to analyze events in context, mashing up data at rest with data in motion, and providing the opportunity to immediately take action to drive revenue and reduce costs.
Sample Event Analytics applications, which use StreamBase to aggregate events into variables for analysis, TERR to score predictive models, and Spotfire® Automation to prepare and deliver event-driven analyses.

TIBCO Spotfire® 6.0 System Requirements
Please note that Microsoft Windows XP is no longer supported for any of the products in the Spotfire® 6 product family. This and all system requirements are found here: http://support.spotfire.com/sr.asp